MS PowerPoint
Module 6
# Table of Contents

Table of Contents ....................................................................................................................... 2
Animation ....................................................................................................................................... 4
Exercise 6A – Animation .............................................................................................................. 6
Animation Pane ............................................................................................................................ 6
Exercise 6B – Animation Pane ...................................................................................................... 8
Slide Sorter View .......................................................................................................................... 9
Exercise 6C – Slide Sorter ........................................................................................................... 10
Slide Show Set Up ....................................................................................................................... 11
Starting a Slide Show .................................................................................................................... 13
Exercise 6D – Start a Slide Show ............................................................................................... 15
Notes ........................................................................................................................................... 16
Exercise 6E – Notes ..................................................................................................................... 18
Printing ......................................................................................................................................... 18
Print Options: ............................................................................................................................... 19
Module Summary .......................................................................................................................... 20
Homework ..................................................................................................................................... 20
Module Six: Animation

Animation was introduced in Module 5 when we studied slide transitions. This module will demonstrate other forms of slide animation. Animation can be a powerful way to keep audience attention. But too much of it will cause the audience to lose sight of the presentation material. Use animation with caution. The module concludes with a discussion of the skills needed to prepare the presentation for delivery to an audience.

Topics

- Animation
- Slide Sorter View
- Slide Show Set Up
- Starting a Slide Show
- Presenter Notes
- Audience Handouts

Exercises

Exercise 6A – Animation
Exercise 6B – Custom Animation
Exercise 6C – Slide Sorter
Exercise 6D – Start a Slide Show
Exercise 6E – Notes

Objectives

At the end of this module participants will be able to:

1. Apply animation to slide elements
2. Use Slide Sorter view to change slide order.
3. Use Slide Sorter view to delete a slide.
4. Set up a slide show to run in a continuous loop.
5. Start a Slide Show.
6. Create presenter notes.
7. Create and print audience handouts.
Animation

Without animation text and objects appear on a slide and remain motionless. Animation can be used to draw viewer attention to text or objects. Animation tools are found on the Animations tab, Animations group.

![Animations Tab](image1)

Figure 6.1 Animations Tab

Use the Animate option to display bulleted list items one at a time.

![Animate Option on Text](image2)

Figure 6.2 Animate Option on Text
In the example shown above the bulleted list was selected and **Fade** was clicked. Moving the mouse over the choices provides a preview.

As shown on the right, the list is now displayed one at a time by fading in to appearance.

This causes your audience’s attention to be drawn to the text and read it as it appears.

Animation can also be added to objects on a slide. In the example below, all objects have been selected and **Fly In** is clicked as well as the **Effects Option**. The **One by One** option will cause all objects on the slide to fly in one by one.

![Figure 6.3 Animate Option on Objects](image)

The audience will be drawn to the movement. Use caution in assigning this form of animation. Used on too many slides may diminish its ability to keep audience attention. Instead it becomes a distraction and can cause loss of focus on the presentation’s content.
Exercise 6A – Animation

This exercise will give you a chance to add animation to the Garden Club Plant Sale presentation.
1. Open the Garden Club presentation.
2. Select a slide that contains a bulleted list.
3. Animate this list trying all of the Fade, Wipe and Fly In options.
4. Select a slide that contains objects.
5. Animate these objects trying all of the Fade, Wipe and Fly In options.
6. Save your work to your flash drive.
7. Do not close PowerPoint.

Click on the Preview option any time you want to be shown the animation assigned to a slide.

Animation Pane

By clicking on the Animation Pane, custom features can be applied which allows more animation choices and control over animation effects. The process starts by selecting the text or objects you wish to animate. Then click the Animation Pane option & select Add Animation.

![Image of Animation Pane](image)

Figure 6.4 Animation Pane

Notice the Animation task pane on the right side of the graphic above. This is where the custom animation effects are listed.
In the example below we have decided to have the selected objects enter using the Shape feature.

![Figure 6.5 Entrance Animation using the Shape option](image)

Use the Play button on the Animation Pane to preview the animation scheme you have selected.
Exercise 6B – Animation Pane

In this exercise let’s take our animation to a new level.
1. Open the Garden Club presentation.
2. Select a slide that contains objects.
3. Select an object and assign it an Entrance option.
4. Select the next object and assign it a different Entrance option.
5. Do this for all objects on the slide.
6. Use the Play button to preview you selected animation.
7. Save your work to your flash drive.
8. **Do not** close PowerPoint.

To remove an animation, select the object and click the **Remove** button.
This completes the course material that deals with slide show content. We now move to the portion of the course that provides tips on preparing the presentation for delivery to an audience.

**Slide Sorter View**

The Slide Sorter view displays a thumbnail view of all slides in a presentation. It gives us a handy way to see all slides in the order they will be presented. Using “drag and drop” we can rearrange the slide order. Slides can also be deleted when in Slide Sorter view.

To enter the Slide Sorter view.

- Click on the Slide Sorter icon on the View tab, Presentation Views group

![Slide Sorter View](image)

*Figure 6.7 Slide Sorter*
If we wish to change the order of a slide in a presentation, select it and “drag and drop” it to the new location.

In the example above slide number 9 was moved to appear as the last slide in the presentation. To delete a slide select it and press the Delete key on the keyboard.

**Exercise 6C – Slide Sorter**

Use this exercise to practice rearranging slide order.
1. Open the Garden Club presentation.
2. Enter Slide Sorter view.
3. Change the order of slides.
4. Delete a slide.
5. Save your work to your flash drive.
6. **Do not** close PowerPoint.
Slide Show Set Up

Now that we have completed the slide show, one final step is to establish how it will be presented. Set Up options are found in the Set Up group of the Slide Show tab.

In almost all cases the default slide show settings will meet your needs. To change the defaults click on the Set Up Slide Show icon. The options are shown below.
The options of interest to us are in the following categories:

**Show Type** – The default is **Presented by a speaker**. This is the option you would select if you are delivering the presentation to a group.

**Show Options** – If you wish to start a presentation and have it run in a continuous loop, select Loop Continuously until" Esc". This option is sometimes selected when a Photo Album is shown at a gathering. Narration and animation can be turned off for a particular presentation.

**Show Slides** – Here you can select all or selected slides to be displayed in your presentation. Use this to customize a presentation.

**Advance Slides** – The default is to use slide advancement based on timing you may have established or manual advancement if that is not present. Slide timing is a topic we did not cover.
Starting a Slide Show

Now that the presentation has been created it is ready for viewing. There are many ways to watch the presentation:

- Select **From Beginning** on the **Start Slide Show** group of the **Slide Show** tab to start from the first slide.
- Select **From Current Slide** on the **Start Slide Show** group of the **Slide Show** tab to start the slide show from the slide currently being displayed.
- Select **Broadcast Slide Show** which allows remote users to view the presentation from a web browser.
- Select **Custom Slide Show** which allows you to display only the slides you choose.

![Figure 6.11 Start Slide Show Options](image)

Once the show begins, the Enter Key, space key, or clicks of the left mouse button can be used to advance through the presentation. You can also use keyboard arrow keys (Right and Down = advance, Left and Up = go Backward) to move through the presentation.
A right mouse click during the slide show brings up the menu show on the slide below.

Figure 6.12 Right Click Options
The most common use of these menu options is to:

- Advance to the next slide
- Back up to the previous slide (Note: the Backspace key can also be used)
- Go to a particular slide
- Cause the screen to go to black or white
- Change pointer options
- End the show (Note: the Esc key can also be used)

**Figure 6.13  Right Click Options – Expanded**

**Exercise 6D – Start a Slide Show**

This exercise will help you prepare for next week’s class presentation.

1. Open the Garden Club presentation.
2. Start the slide show.
3. Use one of the options described to advance through the first five slides.
4. Use the Backspace key to return to slide four.
5. Use an arrow key to return to slide three.
6. Use a “right click” to return to slide two.
7. Continue advancing through the entire slide show.
8. **Do not** close PowerPoint.
Notes

You may have noticed that the bottom of each slide we created there was an area that says “Click to add notes”. This area is called the Notes Pane. You can use Notes Pane to create speaker notes. These notes will help remind you of your talking points for each slide. These notes will be visible to only you during the presentation.

The Notes Pane can also be used to create handout notes for your audience, more on that in the next section of this module.

Figure 6.14 Notes

Notes have been added to the slide shown above. When you present you can refer to these notes and not have to remember that the Coneflowers bloom in summer.

Anything you want to remember can be placed in a note.

All PowerPoint text formatting options apply to the notes you type.
Use the Notes Page view on the View tab to display your notes.

Figure 6.15 Notes Page View

Notes can also be added while in the Notes Page view.
Exercise 6E – Notes

Speaker notes can help a presenter remember a presentation’s important points.
1. Open the Garden Club presentation.
2. Select a slide and add notes (don’t worry about content).
3. Select the Notes Page view.
4. Save your presentation to your flash drive
5. Do not close PowerPoint.

Printing

Your slide show may be printed. You might want to have a copy for your own use or to use as a handout for the audience.

To print, select Print from the File Button.

Figure 6.16 File Button → Print

Print dialog is displayed
Print Options:

Print All Slides – Prints the entire presentation
Slides – Prints selected slides in the presentation.
Full Page Slides – Prints one slide per page.
Print One sided – Only prints on one side of the page.

Full Page Slides – By Clicking on the drop down arrow of this option. The following screen will display which shows additional printing options:

Handouts – Prints slides to be used as an audience handout. You can select to have from 1 to 9 slides printed horizontally or vertically on a page. Printing multiple slides on a page conserves paper. A typical choice would be to print from 4 to 6 slides per page.

Notes Pages – Prints slides and speaker notes. This could be used as an audience handout or could be used just as notes for the speaker.

Outline View – Prints an outline of the presentation.
Module Summary

In this module you gained the skills needed to:

- Apply animation to slide elements
- Use Slide Sorter view to change slide order.
- Use Slide Sorter view to delete a slide.
- Set up a slide show to run in a continuous loop.
- Start a Slide Show.
- Create presenter notes.
- Create and print audience handouts.

Homework

Spend some time this week completing your presentation. Try to incorporate as many of the skills you have gained during this course. If appropriate include:

- Clip art/pictures
- Sounds/movies
- Charts
- Tables
- WordArt
- Text boxes
- Transitions
- Animation
- Select a Theme

Next week you will deliver your presentation to the class, so practice your slide show.

Save your presentation to your flash drive and remember to bring it to class next week.